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1.  Creating a ‘Function Domino’ Game 

In this activity you are going to practice exporting function graphs to the clipboard 
and inserting them into a word processing document in order to create cards for 
a „Function Domino‟ game.  
 

 
 

Preparations 

 Open a new GeoGebra document. 

 Show the algebra window, input field, and coordinate axes (View menu). 

Instructions for GeoGebra 

1  Enter an arbitrary function. 

  Examples: e(x) = exp(x) or f(x) = sin(x) 

2 
 

Move the function graph into the upper left corner of the drawing pad. 

3  
Reduce the size of the GeoGebra window so it only shows the 
desired part of the drawing pad. 

4  Export the drawing pad to the clipboard. 

  Hint: Menu File – Export – Drawing Pad to Clipboard 
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Instructions for MS Word 

1 Open a new word processing document (e.g. MS Word). 

2 Create a table with 2 columns and several rows. 

 Hint: Menu Table – Insert – Table… 

3 Highlight the entire table (all cells) and open the Table Properties dialog. 

 Hint: Menu Table – Table Properties… 

4 Click on tab Row and specify the row height as 2 inches. 

5 Click on tab Column and set the preferred width of the columns to 2 inches. 

6 Click on tab Cell and set the vertical alignment to Center. 

7 Click the OK button. 

8 
Place the cursor in one of the table cells. Insert the function graph picture 
from the clipboard. 

 Hint: Menu Edit – Paste or key combination Ctrl – V 

9 Adjust the size of the picture if necessary. 

 
Hint: Double click the picture to open the Format Picture dialog window. 
Click on tab Size and set the longer side (either width or height) to 1.9”. 

10 Enter the equation of a different function into the cell next to the picture. 

 Hint: You might want to use an equation editor. 

 
Repeat the steps in GeoGebra for a different function (e.g. trigonometric, 
logarithmic) and insert the new picture into MS Word in order to create another 
domino card. 
 
Hint: Make sure to put the equation and graph of each function on different 
domino cards. 

2. Creating a ‘Geometric Figures Memory’ Game 

In this activity you are going to practice exporting geometric figures to the 
clipboard and inserting them into a word processing document in order to create 
cards for a memory game with geometric figures. Make sure you know how to 
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construct different geometric figures (e.g. quadrilaterals, triangles) before you 
begin with this activity. 

Preparations 

 Open a new GeoGebra document. 

 Hide the algebra window, input field, and coordinate axes (View menu). 

Instructions for GeoGebra 

1 Construct a geometric figure in GeoGebra (e.g. isosceles triangle). 

2 Use the Properties dialog to enhance your construction. 

3 
Move the figure into the upper left corner of the drawing pad and adjust the 
size of the GeoGebra window. 

4 Export the drawing pad to the clipboard. 

 Hint: Menu File – Export – Drawing Pad to Clipboard 

 

 

Instructions for MS Word 

1 Open a new word processing document (e.g. MS Word). 

2 Create a table with 2 columns and several rows. 

 Hint: Menu Table – Insert – Table… 

3 Highlight the entire table (all cells) and open the Table Properties dialog. 

 Hint: Menu Table – Table Properties… 
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4 Click on tab Row and specify the row height as 2 inches. 

5 Click on tab Column and set the preferred width of the columns to 2 inches. 

6 Click on tab Cell and set the vertical alignment to Center. 

7 Click the OK button. 

8 
Place the cursor in one of the table cells. Insert the picture of the geometric 
figure from the clipboard. 

 Hint: Menu Edit – Paste or key combination Ctrl – V 

9 Adjust the size of the picture if necessary. 

 
Hint: Double click the picture to open the Format Picture dialog window. 
Then click on tab Size and set the longer side of the picture to 1.9 inches. 

10 Enter the name of the geometric shape into another cell of the table. 

 
Repeat the steps in GeoGebra for a different geometric shape (e.g. 
parallelogram, circle) and insert the new picture into MS Word in order to create 
another memory card. 
 
Hint: Make sure to put the name and sketch of each geometric shape on one of 
the memory cards. 

3. Exploring Symmetry with GeoGebra 

Back to school… 

Open the dynamic worksheet 04_exploring_symmetry.html. Follow the directions 
on the worksheet and experience how your students could explore the axes of 
symmetry of a flower.  
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Preparations 

 Make sure you have the picture 05_flower.jpg saved on your computer. 

 Open a new GeoGebra file. 

 Hide algebra window, input field, and coordinate axes (View menu). 

Introduction of new tools 

 
Show / hide label  New! 

 

Mirror object at line  New! 
Hint: Click the object to be mirrored and then click the line of reflection. 

 
Hints: Don‟t forget to read the toolbar help if you don‟t know how to use these 
tools. Try out the new tools before you start the construction. 

Instructions 

1 
 

New point A 

2 
 

Show the label of point A 

3 
 

Line of reflection through two points 

4 
 

Mirror point A at line to get image A’  

5 
 

Segment between point A and its image A’ 

7  Turn the Trace on for points A and A′ 

  
Hint: Right click (MacOS: Ctrl – click) the point and select Trace on 
from the menu. Whenever point A is moved it leaves a trace on the 
drawing pad. 

8 
 

Move point A to draw a dynamic figure 

9 
 

Insert the image 05_flower.jpg into the drawing pad. 

  
Hint: Click in the lower left corner of the drawing pad to insert the 
picture at this position. 

10 
 

Adjust the position of the inserted image. 

11  Set the image as background image (Properties dialog, tab Basic). 

12  Reduce the filling of the image (Properties dialog, tab Style). 
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Hint: After specifying the picture as a background image you need 
to open the Properties dialog using the Edit menu. You can‟t select 
a background image in the graphics window any more. 

 

Hint: The  Trace on feature has some special characteristics:  

 The trace is a temporary phenomenon. Whenever 
the graphics are refreshed, the trace disappears. 

 The trace can‟t be saved and is not shown in the 
algebra window. 

 To delete the trace you need to refresh the views 
(menu View – Refresh views or key combination 
Ctrl – F. MacOS: Open Apple – F). 

4. Resizing, Reflecting, and Distorting a Picture 

In this activity you will to learn how to resize an inserted picture to a certain size 
and how to apply transformations to the picture in GeoGebra. 

Preparations 

 Make sure you have the picture 
06_Palmtrees.jpg saved on your 
computer. 

 Open a new GeoGebra file.  

 Close the algebra window and 
hide the coordinate axes (View 
menu). 

Instructions for reflecting and resizing a picture 

1 
 

Insert picture 06_Palmtrees.jpg into the left part of the drawing pad 

2 
 

Point A at the lower left corner of the picture 

3  Set point A as the FIRST corner point of your picture. 

  
Hint: Open the Properties dialog and select the picture in the list of 
objects. Click on tab „Position‟ and select point A from the drop-
down list next to Corner 1. 

4  Point B = A + (3, 0) 

5  Set point B as the SECOND corner point of the picture. 

  Hint: You just changed the width of the picture to 3 cm. 
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6 
 

Line through two points in the middle of the drawing pad 

7 
 

Mirror the picture at the line 

  
Hint: You might want to reduce the filling of the image in order to be 
able to better distinguish it from the original (Properties dialog). 

Back to school… 

(a) Move point A with the mouse. How does this affect the picture? 
 
(b) Move the picture with the mouse and observe how this affects its image. 
 
(c) Move the line of reflection by dragging the two points with the mouse. How 
does this affect the image? 

Instructions for distorting a picture 

1  Open the figure you created in the previous activity. 

2 
 

Delete point B to restore the picture‟s original size 

3 
 

Create a new point B at the lower right corner of the original picture. 

4  Set the new point B as the second corner point of your picture. 

  Hint: You can now resize the image by moving point B. 

5 
 

Create a new point D at the upper left corner of the original picture. 

  
Hint: GeoGebra offers a „fast-renaming‟ option. Activate Move 
mode and select the object. When you start typing the new name 
GeoGebra opens the Rename dialog window. 

6  Set the new point D as the FOURTH corner point of your picture 

Back to school… 

(a) How does moving point D affect the 
picture and its image? 
 
(b) Which geometric shape do the 
picture and the image form at any time? 
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5. Exploring Properties of Reflection 

In this activity you will create a dynamic figure that allows your students to 
explore the properties of reflection. 

Preparations 

You will now modify the construction 
created in the previous activity. If you 
want to keep the original as well you 
need to save your file. 

Instructions 

1  
Open the file you created in the previous activity which contains the 
distorted picture of the palm trees and its reflection at a line. 

2 
 

Segment between points A and B 

3 
 

Segment between points A and D 

4 
 

Parallel line to segment AB through point D 

5 
 

Parallel line to segment AD through point B 

6 
 

Intersect the two lines to get intersection point C 

7 
 

Hide auxiliary objects 

8 
 

Reflect all four corner points A, B, C, and D at the line to get their 
images A’, B’, C’, and D’. 

9 
 

Connect corresponding points with segments (e.g. points A and A’) 

10 
 

Create angles between the line of reflection and the segments 

Back to school… 

(a) Move the corner points A, B, C, and D of the original picture. Are you able to 
drag all these points with the mouse? If no, which one can‟t be dragged and 
why? 
 
(b) Move the line of reflection. What do you notice about the angles between the 
segments connecting the corresponding corner points and the line of reflection?  
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6. Translating Pictures 

Preparations 

 Make sure you have the picture 
07_Bart.png saved on your 
computer. 

 Open a new GeoGebra file.  

 Show the algebra window, input 
field, coordinate axes, and grid 
(View menu).  

 In the Options menu set the point 
capturing to on (Grid). 

Introduction of new tools 

 

Vector between two points  New! 
Hint: First click determines the starting point and second click sets the vector‟s endpoint. 

 

Translate object by vector  New! 
Hint: Click the object to be translated and then click the translation vector. 

 
Hints: Don‟t forget to read the toolbar help if you don‟t know how to use these 
tools. Try out the new tools before you start the construction. 

Instructions 

1 
 

Insert picture 07_Bart.png into the first quadrant. 

2  Points A = (1, 1), B = (3, 1), and D = (1, 4) 

3  
Set point A as the FIRST, B as the SECOND, and D as the 
FOURTH corner point of the picture. 

  Hint: Properties dialog –  tab Position 

4 
 

Triangle ABD 

5  Points O = (0, 0) and P = (3, -2) 

6  Vector u = Vector[O, P] 

 
 

Hint: You could also use tool Vector between two points. 
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7 
 

Translate the picture by vector u. 

  Hint: You might want to reduce the filling of the image. 

8 
 

Translate the three corner points A, B, and D by vector u. 

9 
 

Triangle A’B’D’ 

10 
 

Hide point O so it can‟t be moved accidentally.  

11  Change the color and size of objects to enhance your construction. 

7. Rotating Polygons 

Preparations 

 Open a new GeoGebra file. 

 Hide algebra window and input field (View menu). 

 Show the coordinate axes and the grid (View menu). 

 Open the Properties dialog for drawing pad by right clicking the drawing 
pad (MacOS: Ctrl – click). 

o On tab Axes – xAxis change the Distance for x-Axis to 1 
o On tab Axes – yAxis change the Distance for y-Axis to 1 

Introduction of new tool 

 

Rotate object around point by angle  New! 
Hint: Click the object to be rotated, the center of rotation, and enter the angle in the 
appearing dialog window. 

 
Hints: Don‟t forget to read the toolbar help if you don‟t know how to use the tool. 
Try out the new tool before you start the construction. 

Instructions 

1 
 

Create an arbitrary triangle ABC in the second quadrant placing the 
vertices on grid points. 

2 
 

New point D at the origin of the coordinate system 

3  Rename the new point to O 

  
Hint: GeoGebra offers a „fast-renaming‟ option. Activate Move 
mode and select the object. When you start typing the new name 
GeoGebra opens the Rename dialog window. 
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4 
 

Slider for angle α 

  
Hint: In the slider dialog window check Angle and set the increment 
to 90˚. Make sure you don‟t delete the ˚ symbol. 

5 
 

Rotate triangle ABC around point O by angle α 

  Hint: Check counter clockwise rotation. 

7 
 

Segments AO and A’O 

8 
 

Angle AOA’ 

  
Hint: Select the points in counter clockwise order. Hide the label of 
this angle. 

 

 

Enhancing the construction 

You will now learn how to „tidy up‟ the algebra window by defining some objects 
as „Auxiliary objects‟ and hiding their algebraic representation from view.  

 Show the Algebra window. 

 Open the Properties dialog. 

 Select all segments in the Properties dialog and check Auxiliary object on 
tab „Basic‟.  
Hint: Click on the heading „Segment‟ in order to select all segments. 

 Repeat this step for the triangles, angles, and point O at the origin.  
Hint: The algebra window now only contains points A, B, and C as well as 
their images A’, B’, and C’. 

 Make sure the item Auxiliary objects is unchecked in the View menu. 
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Note: Your students can now check out the coordinates of the initial points and 
their images in the algebra window without being distracted by the algebraic 
representation of the other objects used in this construction. 

8. Challenge of the Day: Tilings with Regular Polygons 

Go to folder 08_Tilings and open the dynamic worksheet 01_tilings_triangle.html. 
It is the first one of a series of ten dynamic worksheets that form a learning 
environment to explore tilings with regular polygons.  
 
Hint: Use the links “previous | back” in the upper right corner of the dynamic 
worksheets to navigate in this learning environment. 

Back to school… 

(a) Work through the tasks on the dynamic worksheets of this learning 
environment.  Write down your answers on paper and discuss them with 
colleagues afterwards. 
 
(b) After working through the dynamic worksheets you should be able to answer 
the following questions: 

 Which regular polygons can be used to tile the plane?  

 Which transformation(s) did you use for the tilings?  

 How many of each of these polygons meet at one of their edges?  
 
(c) Fill in the missing values in the table below. Can you see any patterns? Try to 
find the formulas for an n-sided polygon. 
 

polygon parts polygon 

#  
vertices 

tiling possible 

yes / no 
# meet central angle interior angles interior angles 

3   --- ---  

4      

5      

6      

7      

… … … … … … 

n      
 
(d) Come up with a conjecture that helps you to reason why not every regular 
polygon can be used for tilings. 
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Tilings with regular polygons – worksheet solution 

 

polygon parts polygon 

# of 
vertices 

tiling 
possible 

yes / no 

# for 
tiling 

central angle interior angles interior angles 

3 yes 6 --- --- 60  

4 yes 4 


90
4

360
  



45
2

90180



  90452   

5 no --- 


72
5

360
  



54
2

72180



  108542   

6 yes 3 


60
6

360
  



60
2

60180



  120602   

7 no --- 


7

3
51

7

360
  






7

2
64

2

7

3
51180





 



7

4
128

7

2
642   

… … … … … … 

n 

no 

for 

6n  

--- 
n

360
 

2

180 360
n


 

n


 360

180   

 
 
 
 


	Creating a ‘Function Domino’ Game
	Preparations
	Instructions for GeoGebra
	Instructions for MS Word

	Creating a ‘Geometric Figures Memory’ Game
	Preparations
	Instructions for GeoGebra
	Instructions for MS Word

	Exploring Symmetry with GeoGebra
	Back to school…
	Preparations
	Introduction of new tools
	Instructions

	Resizing, Reflecting, and Distorting a Picture
	Preparations
	Instructions for reflecting and resizing a picture
	Back to school…
	Instructions for distorting a picture
	Back to school…

	Exploring Properties of Reflection
	Preparations
	Instructions
	Back to school…

	Translating Pictures
	Preparations
	Introduction of new tools
	Instructions

	Rotating Polygons
	Preparations
	Introduction of new tool
	Instructions
	Enhancing the construction

	Challenge of the Day: Tilings with Regular Polygons
	Back to school…
	Tilings with regular polygons – worksheet solution


